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Introduction

Welcome to Mac OS X Lion On Demand, a visual quick refer-
ence book that shows you how to work efficiently with Apple
Mac OS X Lion.  This book provides complete coverage of
basic to advanced Mac OS X skills.

How This Book Works
You don’t have to read this book in any particular order.
We’ve designed the book so that you can jump in, get the
information you need, and jump out. However, the book does
follow a logical progression from simple tasks to more com-
plex ones. Each task is presented on no more than two facing
pages, which lets you focus on a single task without having
to turn the page. To find the information that you need, just
look up the task in the table of contents or index, and turn to
the page listed. Read the task introduction, follow the step-
by-step instructions in the left column along with screen illus-
trations in the right column, and you’re done.

What’s New
If you’re searching for what’s new in Mac OS X Lion, just look
for the icon: New!. The new icon appears in the table of con-
tents and throughout this book so you can quickly and easily
identify a new or improved feature in Lion. A complete
description of each new feature appears in the New Features
guide in the back of this book.

Keyboard Shortcuts
Most menu commands have a keyboard equivalent, such as
A+P, as a quicker alternative to using the mouse. A complete
list of keyboard shortcuts is available on the Web at 
www.perspection.com.

How You’ll Learn

How This Book Works

What’s New

Keyboard Shortcuts

Step-by-Step Instructions

Real World Examples

Workshop

Get More on the Web

www.perspection.com
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Step-by-Step
Instructions
This book provides concise step-
by-step instructions that show you
“how” to accomplish a task. Each
set of instructions includes illus-
trations that directly correspond to
the easy-to-read steps. Also
included in the text are time-
savers, tables, and sidebars to
help you work more efficiently or
to teach you more in-depth infor-
mation. A “Did You Know?” pro-
vides tips and techniques to help
you work smarter, while a “See
Also” leads you to other parts of
the book containing related infor-
mation about the task. 

Real World Examples
This book uses real world exam-
ples files to give you a context in
which to use the task. By using
the example files, you won’t waste
time looking for or creating sam-
ple files. You get a start file and a
result file, so you can compare
your work. Not every topic needs
an example file, such as changing
options, so we provide a complete
list of the example files used
through out the book. The exam-
ple files that you need for project
tasks along with a complete file
list are available on the Web at
www.perspection.com.

Real world
examples help
you apply what
you’ve learned
to other tasks.

Illustrations
match the
numbered
steps.

Numbered
steps guide
you through
each task.

Did You Know? alerts
you to tips, techniques
and related information.

See Also points you to
related information in
the book.

Easy-to-follow
introductions
focus on a
single concept.

www.perspection.com


Workshops
This book shows you how to put
together the individual step-by-
step tasks into in-depth projects
with the Workshop. You start each
project with a sample file, work
through the steps, and then com-
pare your results with project
results file at the end. The Work-
shop projects and associated files
are available on the Web at
www.perspection.com.

Get More on the Web
In addition to the information in
this book, you can also get more
information on the Web to help
you get up to speed faster with
Mac OS X. Some of the informa-
tion includes: 

Transition Helpers
◆ Only New Features.

Download and print the new
feature tasks as a quick and
easy guide.

Productivity Tools
◆ Keyboard Shortcuts.

Download a list of keyboard
shortcuts to learn faster ways
to get the job done. 

The Workshops
walks you through
in-depth projects
to help you put
the Mac OS X
Lion to work.

Introduction xix

Additional
content
is available
on the Web.

www.perspection.com
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More Content
◆ Photographs. Download

photographs and other
graphics to use in your
documents.

◆ More Content. Download
new content developed after
publication.

You can access these additional
resources on the Web at
www.perspection.com.

Download and
use Photographs
to help you add
impact to your
documents.

www.perspection.com


Finding What You Want with
Spotlight

Introduction

If you’re looking for specific content on your computer or net-
work and you don’t know where to find it, you can use
Spotlight to help you locate it. Spotlight not only searches
the names of your files and folders, it also searches their con-
tent. In addition, Spotlight searches other information stored
in files, known as metadata, which describes how and when
and by whom a particular set of data was collected, or how
the data is formatted. Examples of metadata include authors,
page size, creation and modification dates, duration of music
and movies, dimensions of graphics or PDF documents,
exposure time of a camera lens for photographs, and names
of layers in Photoshop.

Spotlight is conveniently located on the right side of the
menu bar on your Mac screen. You can identify Spotlight by
the blue icon with a magnifying glass. Spotlight performs a
live search of your Home folder on your computer using the
information you know. As you type in Spotlight, a menu
appears displaying a list of everything Spotlight can find to
match what you’ve typed so far. As you continue to type, the
list changes. Spotlight searches for everything on your com-
puter that matches what you’ve typed, which includes every
file, folder, program, e-mail message, address book entry,
calendar appointment, picture, movie, PDF document, music
file, Web bookmark, Microsoft Office document, and System
Preferences panel, and lists the 20 best matches divided into
categories, which you can customize later. 

When you start Mac OS X for the first time, Spotlight
automatically starts collecting search information about your
Home folder, known as indexing. The indexing process ini-
tially takes about 15 to 30 minutes to perform (the Spotlight
icon pulses) and then updates take place as needed. Indexing
the information on your computer reduces the time it takes
to perform a search.

3

3
What You’ll Do

Find Information Using Spotlight

Find Information in the Spotlight
Window

Filter Spotlight Results

Group and Sort Spotlight Results

Work with Spotlight Results

Set Spotlight Preferences

Search for Files Using the Find Window

Search for Hard to Find Information

Work with Find Window Results

Create and Use Smart Folders 

Get Help While You Work

Get Help Using Spotlight

55



If you’re looking for specific content on your computer and you don’t
know where to find it, you can use Spotlight to help you find it. Even if
you can only remember part of the content. Spotlight performs a live
search of your Home folder on your computer using the information you
know. As you type in Spotlight, a menu appears displaying a list of
everything Spotlight can find to match what you’ve typed so far. As you
continue to type, the list changes. If you type two words, Spotlight finds
items that contain both words. Spotlight searches for everything on your
computer that matches what you’ve typed, which includes every file,
folder, program, e-mail message, address book entry, calendar appoint-
ment, to-do item, picture, movie, PDF document, music file, Web book-
mark, document, and System Preferences panel, and lists the 20 best
matches divided into categories, which you can customize later.
Spotlight not only searches the names of your files and folders, it also
searches their content, and displays a preview of the material (New!)
from the menu. In addition, you can drag items from the Spotlight menu
(New!) for use in folder or on the desktop. You can search by typing
phrases or metadata attributes, and using boolean operators.

56

Finding Information
Using Spotlight

Find Information Using Spotlight

Click the Spotlight (magnifying-
glass) icon on the right side of the
menu bar.

TIMESAVER Press A+Space
bar to open Spotlight. 

In the Spotlight field, start to type
what you want to find. To find a
specific phrase, place quotes
around it. 

As you type, a menu begins to
display a list of everything
Spotlight can find to match what
you’ve typed so far. As you
continue to type, the list changes.

To preview an item (New!), point
to the item in the list.

To copy an item (New!), drag the
item off the Spotlight list.

To open an item, click the item or
use the arrow keys to scroll down
the list, and then press Return.

To clear or stop a search, click the
Close button (x) in the Spotlight
field.

6

5

4

3

2

1
12

6

5

3Preview of search item

4Wikipedia



Chapter 3 Finding What You Want with Spotlight 57

Find Information with Metadata
Using Spotlight

Click the Spotlight (magnifying-
glass) icon on the right side of the
menu bar.

TIMESAVER Press A+Space
bar to open Spotlight. 

In the Spotlight field, type
code:keyword. Use quotation
marks around text to search for an
exact phrase.

Where the code is a category, such
as kind, date, modified, or author,
and keyword is a specific type of
category.

Here are some examples:

◆ kind:preference network
displays the network system
preference on your computer. 

◆ kind:contact steve displays all
the contacts with the name
steve on your computer. 

◆ kind:music by:”Bruce
Springsteen” displays all music
by Bruce Springsteen.

◆ date:today kind:email displays
all the email for today on your
computer. 

2

1

Did You Know?
You can quickly cancel a Spotlight
search. Press the Esc key to close the
Spotlight menu and erase what you’ve
typed. Now, you can type a new
search. Press the Esc key again to
cancel the entire search. To cancel the
entire search in one step, press
A+Space bar again, A+period, or
A+Esc.

Using Boolean Operators to Help Your Search

If you can’t find the information you are looking for using the Spotlight
field or Search field, you can use boolean operators (AND, OR, NOT,
and dash (-) for AND NOT to exclude items) to refine your help search.
For example, typing report AND proposal finds both words, typing
report OR proposal finds either report or proposal, while typing report
NOT proposal finds report, but excludes proposal. If you type report -
proposal, Spotlight finds report but not proposal. You can also use key-
words in your search with boolean operators. For example, typing
kind:pdf report AND kind:presentation proposal, finds PDF documents
with report and presentation files with proposal.

For Your Information

Find Code:Keyword

Program kind:app, kind:application

Address book contact kind:contact

Folder kind:folder

Mail message kind:email, kind:mail message

iCal appointment kind:event

iCal task kind:to do, kind:todo

Image, picture kind:image

Movie kind:movie

Music or Sound kind:music, kind:audio

PDF file kind:pdf

System Preference kind:preference, kind:system preference

Safari bookmark kind:bookmark

Font kind:font

Presentation kind:presentation

Week date:this week, date:next week

Month date:this month, date:next month

Year date:this year, date:next year

Today date:today

Tomorrow date:tomorrow

Yesterday date:yesterday

Find Code and Keywords



If you can’t find what you’re looking for on the Spotlight menu with the
20 most likely matches, you can click the Show All in Finder command
at the top of the Spotlight menu to open the Spotlight window and view
the complete list of matches organized by category. The Show All in
Finder command  displays the results of your search by retrieving con-
tent on your entire computer that matches the criteria. The Search bar,
located below the toolbar, indicates the search location and type,
which is “This Mac,” folder or disk name, such as “Documents” or “All
My Files” (New!), and “Shared” by default. You can search your entire
computer (This Mac), your Home folder (All My Files), or shared net-
work computer by the file name and the contents of a file.
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Finding Information 
in the Spotlight
Window

Open and View the Spotlight
Window to Locate Information

Click the Spotlight (magnifying-
glass) icon on the right side of the
menu bar.

TIMESAVER Press
Option+A+Space bar to open
Spotlight window directly. 

In the Spotlight field, start to type
what you want to find. 

Click Show All in Finder on the
Spotlight menu. 

The Spotlight window opens,
displaying the results of your
search by category.

If a search is currently in progress,
a sprocket icon whirls around in
the upper-left window corner. 

To narrow or change the search,
type the text you want to find in
the Search field. 

To open an item, double-click the
item or use the arrow keys to
scroll down the list, and then press
Return.

To clear or stop a search, click the
Close button (x) in the Search
field.

When you’re done, click the Close
button.

7

6

5

4

3

2

1

12

3

4

6

5

7



Chapter 3 Finding What You Want with Spotlight 59

Narrow Results in the Spotlight
Window

Press Option+A+Space bar or
click Show All in Finder on the
Spotlight menu to open the
Spotlight window.

The Spotlight window opens,
displaying the results of your
search by category.

If a search is currently in progress,
a sprocket icon whirls around in
the upper-left corner of the
window. 

In the Search bar, click the button
with the search location you want:

◆ This Mac. Searches all the
disks on your computer.

◆ All My Files. Searches your
Home folder.

◆ Server, Volume or Folder Name.
Searches only the currently
opened server, volume, or
folder. The item name appears
in quotes in the Search bar.

◆ Shared. Searches shared
folders on disks and computer.

To narrow or change the search,
type the text you want to find in
the Search field. 

To open an item, double-click the
item or use the arrow keys to
scroll down the list, and then press
Return.

To clear or stop a search, click the
Close button (x) in the Search
field.

When you’re done, click the Close
button.
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Searching Made Easy

You can add text to the Spotlight Comments field in the Get Info dialog
for a specific file or folder that you can quickly search for using
Spotlight later. Control-click a file or folder, click Get Info, and then
type the text you want in the Spotlight Comments field. 

For Your Information
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If the list of Spotlight results is too long to find the results you want, you
can revise your search text in the Search field or use the Search bar to
filter, or narrow down, the list. The Search bar allows you to filter down
the Spotlight results by location and type. The left side of the Search
bar provides buttons to filter the search results by where the informa-
tion is stored, such as This Mac (your entire computer), All My Files
(your Home folder), or Shared (your networked computers), if available.
After you select where, you can select how. You can filter the result by
whether the search criteria is in the content of a file or the file name of
the results. If you want to further narrow down the Spotlight results,
you can add other search criteria using file attributes.

Filtering Spotlight
Results

Filter Spotlight Results

Press Option+A+Space bar or
click Show All in Finder on the
Spotlight menu to open the
Spotlight window, and then
perform or narrow a search.

The Spotlight window displays the
results of your search by category.

In the Search bar, click the button
with the search location you want:

◆ This Mac. Searches all the
disks on your computer.

◆ All My Files. Searches your
Home folder.

◆ Server, Volume or Folder Name.
Searches only the currently
opened server, volume, or
folder. The item name appears
in quotes in the Search bar.

◆ Shared. Searches shared
folders on disks and computer.

To clear a search, click the Close
button (x) in the Search field.

When you’re done, click the Close
button.
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Change Spotlight Criteria in the
Spotlight Window

Press Option+A+Space bar or
click Show All in Finder on the
Spotlight menu to open the
Spotlight window.

The Spotlight window opens,
displaying the results of your
search by category.

If a search is currently in progress,
a sprocket icon whirls around in
the upper-left corner of the
window. 

Click the Action button, and then
click Show Search Criteria.

The Spotlight items option appears
in the first Search pop-up,
indicating Spotlight results in the
window.  

Click the Add (+) button, and then
specify the criteria you want.

Click the first Search pop-up of the
second criteria item, and then
select or type the search criteria.

◆ Select Other on the pop-up to
display a complete list of
searchable attributes.

Click the second Search pop-up of
the second criteria item, and then
select or type more specific
search criteria.

To remove search criteria, click
the Remove (-) button.

Click the Action button, and then
click Hide Search Criteria.

To clear or stop a search, click the
Close button (x) in the Search
field.

When you’re done, click the Close
button.
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After you perform a search using the Spotlight window, you can use the
Arrange By button, Arranged By submenu on the Action menu or the
column header button in List or Cover Flow view to group and sort the
results of your search to make it easier to find what you’re looking for.
Clicking on one of the column header buttons—such as Name, Kind, or
Last Opened (default options)—in the search result window in either List
or Cover Flow view, sorts the files and folders by the type of information
listed in the column. If the columns are not organized in the order you
want, you can use the mouse to quickly drag a column header to
rearrange them.

Grouping and Sorting
Spotlight Results

Group and Sort Spotlight Results

Press Option+A+Space bar or
click Show All in Finder on the
Spotlight menu to open the
Spotlight window, and then
perform or narrow a search.

The Spotlight window displays the
results of your search by category.

Click the List View or Cover Flow
button on the toolbar to display the
search results in list form.

Click a column header name
(default shown) to sort the file and
folder in ascending or descending
order:

◆ Name. List in alphabetical order
by element name.

◆ Kind. List by kind of item,
including applications,
documents, or images.

◆ Last Opened. List by the date
you last opened it.

To change the view options, click
the Action button, click Show
View Options, select options, and
then click the Close button.

When you’re done, click the Close
button.
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Select view options for
Spotlight search results
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After you perform a search using the Spotlight window, you can
Control-click an item to display a shortcut menu and get more informa-
tion about an item in the Spotlight results. When you Control-click an
item, the shortcut menu allows you to open the item, get information
about the item from the Get Info dialog box, locate the item in the
Finder, display a slide show for graphic items, or create an e-mail with
attachments using Mail.

Working with
Spotlight Results

Work with Spotlight Results

Press Option+A+Space bar or
click Show All in Finder on the
Spotlight menu to open the
Spotlight window, and then
perform or narrow a search.

The Spotlight window displays the
results of your search by category.

Control-click or right-click the
item(s) you want, and then click
the option you want:

◆ Open. Opens the selected
item(s).

◆ Open With. Opens the selected
item(s) with a specified
application. Point to Open With,
and then select an available
application.

◆ Open Enclosing Folder.
Displays the selected item(s) in
a Finder window.

◆ Get Info. Opens the Get Info
dialog box with basic file infor-
mation for the selected item(s).

◆ Quick Look. View the contents
of a file or folder without
opening it.

When you’re done, click the Close
button.

3

2

1 3 2



You can change Spotlight preferences to customize the way you use
Spotlight. You can specify the categories, such as Applications,
Documents, Folders, and so on, you want or don’t want to include in a
Spotlight search. In addition, you can change the order of the cate-
gories to prioritize the way the results appears. If you prefer different
shortcut keys to display the Spotlight menu or open the Spotlight win-
dow, you can change them. When Spotlight performs a search, it looks
every where on your computer (except for someone else’s Home
folder). If you want to keep certain disks, partitions, or folders private,
you can add them to your privacy settings in Spotlight preferences.
When you add an item to the privacy list, Spotlight removes them from
the Spotlight index.
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Setting Spotlight
Preferences

Set Spotlight Search Results
Preferences

Click the System Preferences icon
in the Dock, and then click the
Spotlight icon.

TIMESAVER Click Spotlight
preferences at the bottom of the
Spotlight menu (after you’ve
started a search).

Click the Search Results tab.

Select the check boxes you want
to include in the search results or
clear the check boxes you don’t
want to include in the search
results.

To change the order to the search
results categories, drag the
categories to the location you
want.

Click the Close button.5
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Did You Know?
You can use Spotlight everywhere
(almost). The Spotlight Search field is
also available in the Finder, Mail,
System Preferences, and Open and
Save dialogs to name a few.

Selecting the Default Search Location

You can specify the default search location for Spotlight. Click the
Finder menu, click Preferences, click Advanced, click the When per-
forming a search pop-up, then click Search This Mac, Search the
Current Folder, or Use the Previous Search Scope.

For Your Information
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Set Spotlight Privacy
Preferences

Click the System Preferences icon
in the Dock, and then click the
Spotlight icon.

Click the Privacy tab.

Drag the items (disks, partitions, or
folders) to the list of non-
searchable items from the
desktop, or click the Add (+)
button, navigate to the item, and
then click Choose.

To delete an item, click the item,
and then press Delete or click the
Remove (-) button.

Click the Close button.

Set Keyboard Shortcuts for
Spotlight

Click the System Preferences icon
in the Dock, and then click the
Spotlight icon.

Select the Spotlight menu
keyboard shortcut check box, click
the list arrow, and then select the
shortcut you want.

Select the Spotlight window
keyboard shortcut check box, click
the list arrow, and then select the
shortcut you want.

Click the Close button.4
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Searching for Files
Using the Find 
Window

Search for Files Using the Find
Window

Open a Finder window.

Click the File menu, and then click
Find.

TIMESAVER Press A+F to
open the Find window.

In the Search field, type the text in
which you want to search.

On the Search menu, select a
suggestion, such as Filename
contains “text” to narrow the
search as desired. (New!)

Click the button with the search
location you want:

◆ This Mac. Searches all the
disks on your computer.

◆ All My Files. Searches your
Home folder.

◆ Server, Volume or Folder Name.
Searches only the currently
opened server, volume, or
folder. The item name appears
in quotes in the Search bar.

◆ Shared. Searches shared
folders on disks and computer.

To change the search, click the
drop-down button, and then click
Filename or Everything.
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Spotlight provides a quick and easy way to search for files, but if you
need to perform a more specific search, the Find window can help you
search for what you need. The Find window lets you specify where and
how you want to search—This Mac, All My Files or “folder or disk
name,” or Shared—with either file contents or name and make relevant
suggestions as you type (New!). You can narrow your search by select-
ing or typing a specific list of criteria—such as name, location, size, or
kind—available in the Find window. For example, you can search for all
graphic files with the .jpg extension you created last month that contain
web. After you complete a search, a separate results window opens.
Unlike the Spotlight, you can change the criteria and perform a new
search, and then compare the results. 
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Narrow Search for Files Using
the Find Window

Click the File menu, and then click
Find.

In the Search field, type the text in
which you want to perform an
initial search.

Click the first Search pop-up, and
then select or type the search
criteria; options vary depending on
the criteria.

◆ Kind. Finds files that are or
aren’t a certain kind.

◆ Last Opened Date. Finds files
that you last opened.

◆ Last Modified Date. Finds files
according to the date modified.

◆ Created Date. Finds files
according to the date created.

◆ Name. Finds all or part of a file
name (capitalization doesn’t
matter); select another option,
such as Contains, Starts With,
Ends With, or Is.

◆ Contents. Finds words inside
your file; handy if you don’t
remember the name.

◆ Other. Finds files based on
other selected attributes.

Click the second Search pop-up,
and then select or type more
specific search criteria.

To add search criteria, click the
Add (+) button, and then specify
the criteria you want.

To remove search criteria, click
the Remove (-) button.

The search results appear in the
window.

To pause or stop a search in
progress, click the X button.

7

6

5

4

3

2

1

4

5

3

7

6

Setting a Search Location Preference

In the Finder Preferences dialog, you can specify a search location
preference. You can select any of the following options: Search This
Mac, Search the Current Folder, or Use the Previous Search Scope.
Click the Finder menu, click Preferences, click Advanced, click the
When performing a search pop-up, and then select the option you
want.

For Your Information

2
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In addition to searching for typical information, such as name, location,
size, or kind, you can also search for file specific metadata, such as
visibility (visible files, not hidden one used by Mac OS X), duration,
dimensions, pixel height and width, device make, and layers. There are
over 115 different metadata search attributes from which to choose. For
example, you can select search attributes to find visible files (not hid-
den ones used by Mac OS X), the duration of music and movies, the
dimensions of graphics or PDF documents, the device used to acquire
a document, and the names of layers in Photoshop.

Searching for Hard to
Find Information

Search for Hard to Find
Information

In the Finder, click the File menu,
and then click Find.

TIMESAVER Press A+F to
open the Find window.

◆ You can also use the Search
field located in every Finder
window.

In the Search field, type the text in
which you want to search.

To display only matches with
filename, select Filename contains
“text” on the Search menu.

At the top of the window, click the
button with the search location
you want: This Mac, All My files
or “folder or disk name,” or
Shared.

Click the first Search pop-up, and
then click Other.

Select the search attribute you
want to find.

Click OK.7
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After you perform a search with the Find window, you can perform a
variety of file management operations directly with the Find window
results, which are similar to the ones you can perform in the Finder. For
example, you can get file information, and move, copy, rename, or
delete a file directly in the search results window. In addition, you can
display the location of a file in the search results window, and then
open its folder location or open the file. 

Working with Find
Window Results

Work with Find Window Results

After you perform a search with the
Find window, you can use the following
options to work with the results:

◆ Find the location of a file. Click a
file to display the location in the
Path bar at bottom of the window.

◆ Open the location of a file. Click
the File menu, and then click Open
Enclosed Folder.

◆ Open a file. Double-click the file
icon.

◆ Move or delete a file. Drag the file
to a new location or the Trash.

◆ Rename a file. Click its name,
select the text, and then type a
new name.

◆ Copy a file. Use the Copy and
Paste commands on the Edit
menu.

◆ Get file information. Click the File
menu, and then click Get Info. Add
criteria to Spotlight Comments for
use in Spotlight searches. 

◆ Sort the result by category. Click
the column header.

◆ Start a new search. Change the
text in the Search field, or click the
Close (x) button in the Search field
and type a new search.

◆ Close the search. Click the Close
button or press A+W.

Path bar

Double-click to open Click column to sort

Get info 
spotlight comments
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A Smart folder is a self-updating folder that performs a search based
on the search criteria you set and save in the Search dialog box. You
can create a Smart folder by specifying a search in the Search dialog
box and then saving it as a saved search. For example, if you set up a
search for Last Opened and This week, and saved it as a Smart folder.
In the Sidebar, you can click the Smart folder to perform the smart
search, or Control-click it and click Show Search Criteria to edit it.

Creating and Using
Smart Folders

Create and Use a Smart Folder

Click the File menu, and then click
New Smart Folder.

Use the Add (+) button to specify
the search criteria you want to
save as a Smart folder.

Click the Save button.

Type a name for the Smart folder.

Specify the location where you
want to save the Smart folder. 

The default location is the Saved
Searches folder.

Select or clear the Add To Sidebar
check box to either add or not add
the Smart folder to the sidebar.

Click Save.

To use a Smart folder, click the
Smart folder icon on the Sidebar,
or navigate to the Saved Searches
folder, and then double-click it.

◆ The Saved Searches folder is
located in the Library folder,
which is located in the Home
folder.
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Smart
folder

Did You Know?
You can open a recent item. Click the
Apple menu, point to Recent Items, and
then click the recently used document
you want to open. 
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Edit a Smart Folder

Navigate to the Smart folder you
want to edit; you can click Smart
folder in the Sidebar to select to
display it.

Click the Action menu, and then
click Show Search Criteria.

Change the search criteria you
want to modify.

Click Save.

Click the Action menu, and then
click Hide Search Criteria.
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Did You Know?
Where’s the Smart folder? The Smart
folder is located in the Saved Searches
folder in the Library folder, which is
located in the Home folder. 

You can delete a Smart folder. Control-
click the smart folder in the Sidebar,
click Open Enclosing folder, and then
drag the Smart folder you want to
delete to the Trash icon. 

You can remove a Smart folder from
the Sidebar. Control-click the smart
folder in the Sidebar, and then click
Remove from Sidebar. The folder is
removed from the sidebar, however it
remains in the Save Searches folder.

You can add a Smart folder or other
folder to the Sidebar. Select the folder
in a Finder window or desktop, click
the File menu, and then click Add To
Sidebar.

Saved Searches folder

Items grayed out, not accessible.
Drag to trash to delete.
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When you have a question about how to do something in Mac OS X, you
can usually find the answer with several clicks of your mouse. Mac OS
X Help is a resource of information to help you use Mac OS X. The Mac
OS X Help Center is like an online book with a table of contents, com-
plete with a search feature, and additional links to the Internet to make
finding information a little bit easier. You can access help from the Help
menu in the Finder as well as many other Mac OS X applications, such
as Safari and iChat; you can even switch between the different help
libraries using the Home button. If you see the Help button (question
mark) in a window or dialog, you can click it to get feature related help.
If you have an Internet connection, Help retrieves online updates to
Mac OS X Help content as necessary. For additional help and support
information, visit the Apple Web site at www.apple.com.

Getting Help While
You Work

Browse for Help Information

In the Finder, or any other
application, click the Help menu,
and then click Help Center or
<application name> Help.

To select another Help, click the
Help for all your apps link, and
then click a help library.

Click a link in the Help window
until you find the topic with the
information you’re looking for.

Use the Help toolbar to
navigation help topics:

◆ Click the Back and Forward
button to view previously
viewed topics.

◆ Click the Action button to
change text size, find and high-
light text on current page, or
print current topic. 

◆ Click the Home button to return
to the first page of the help. 

◆ Click the Add Bookmark button
to add the current help topic to
bookmarks. Click Bookmarks
button to display the bookmark
list to open, remove or email. 

Click the Close button to quit
Help.
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Find on page

www.apple.com
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Search for Help Information

In the Finder, or any other
application, click the Help menu,
and then click Help Center or
<application name> Help.

Click the magnifying glass in the
Search field, and then click
Include Product Support Results
to check or uncheck it.

Click in the Search field.

TIMESAVER Press the Tab key
to quickly go to the Search field.

Type the words you want to find
in the help topics, and then press
Return.

A list of matches appears with a
Relevance column ranking the
results by percentage.

Double-click the topic you want
to read in the search results list.

Use the navigation buttons (Back
and Forward) on the Help toolbar
to move between help topics.

Click the Close button to quit
Help.
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Did You Know?
You can start a new search in a new
window. Click the File menu, click
New, and then perform a new search.

You can print a help topic. Display the
help topic in the Help window, click the
Action button on the Help toolbar, click
Print, and then click Print again.

You can change the size of Help text.
Click the Action button on the Help
toolbar, click Make Text Smaller or
Make Text Bigger.
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In addition to using Spotlight to find files and other information on your
computer, you can also use Spotlight to quickly find help information.
When you click the Help menu, the Spotlight Search field appears at
the top, where you can type the help information you want to find and
display. You can access help from the Help menu in the Finder as well
as many other Mac OS X applications, such as Safari and iChat. When
you select a help topic from the Help menu, the Help window appears
displaying the topic. If you want to display all the related help topics,
click Show All Help Results. A complete search results appears, where
you can double-click a topic to display it. If available, menu items
appear on the Help menu, where you can select it to display an blue
arrow pointing to the location of the menu.

Getting Help Using
Spotlight

Get Help Using Spotlight

Click the Help menu.

In the Spotlight Search field, start
to type what you want to find. To
find a specific phrase, place
quotes around it. For example,
“Preferences”

As you type, a menu begins to
display a list of everything
Spotlight can find in Help to match
what you’ve typed so far. As you
continue to type, the list changes.

On the Help menu, select one of
the following options:

◆ Display a Help Topic. Click the
Help topic item or use the
arrow keys to scroll down the
list, and then press Return to
open the Help window.

◆ Show All Help Results. Click
Show All Help Results to
display the search results for
help topics, and then double-
click the topic you want to
open the Help window.

◆ Display a Menu Item. Point to
the Menu item name to display
a blue arrow pointing to the
location of the menu item.

Click the Close button to quit
Help.
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Index

A
Abstract Background, 100
Access Control Lists (ACLs), 478
accounts. See also Mail

iChat accounts, creating, 290-291
Acrobat Reader. See also PDF files

downloading, 209
actions. See Automator
ActionScripting, 507
activating/deactivating

fonts, 155
login window, 387
windows, 12-13

activities preferences, setting, 122-123
Activity Monitor, 444-445
Address Book, 127, 131.

archiving data, 141
Bluetooth with, 412
creating, 140-141
Dashboard displaying, 158-159
Directory for sharing information, 145
editing contact information, 142-143
faxes, addressing, 214
iChat buddies from, 296
images, adding, 142
iPhoto pictures from, 142
managing contacts, 144
MobileMe Address Book, 355
pictures to contacts, adding, 142
printing from, 143
Safari Bookmarks bar, adding to, 238-239
sending e-mail from, 266-267
sharing, 144-145
Smart Addresses, using, 266
Spotlight searches, keywords for, 57
subscribing to, 145
vCards, 141, 144-145

Administrator, 386
file permissions, setting, 390
master password, restoring, 398-399
Safari preferences, setting, 253
in Simple Finder, 92

Adobe Acrobat. See also PDF files
downloading, 209

AIM, iChat with, 289, 291
with Address Book, 142-143

AirDrop
sending files wirelessly, 421

AirPort. See also Wi-Fi
Admin Utility, 430
configuring connection, 218
desktop icon, 5
iChat with, 308
with Mac for Windows, 465, 472
making Internet connection with, 224
multiple connections with, 219
network port configuration for, 223
printers, sharing, 202-203
setting up, 222

AirPort Extreme Base Station, 481
alerts

changing sounds, 112
forms, sending nonsecure, 243
iChat notification alerts, 312
speaking voice for, 116

Alex
default speaking voice, setting, 116
interface options, setting, 117
for VoiceOver, 120

aliases, 75, 395
creating, 88-89

alignment
of document text, 178
of e-mail message text, 269
of tables, 185
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All My Files, 28-29
AND operator, searching with, 57
animated GIFs

creating, 297
movies as animated GIFs, exporting, 335

anti-aliasing, 98-99
Anywhere mode, 168
AOL and iChat, 217, 289-290

setting up accounts, 258
appearance (general) options, changing, 

98-99
Apple

sending diagnostic & usage data to, 397
Apple Account number for iTunes Music

Store, 320
Apple Background, 100
Apple Developer Connection Web site, 162
Apple Events, sharing, 405
Apple Hardware Test, 450
Apple ID

password, changing, 398-399
Apple Magic Mouse, 6, 33, 132

Dashboard preferences, changing, 157
with Mac for Windows, 472

Apple Remote, 465.
iPod Hi-Fi, 315
with Mac for Windows, 465, 472

AppleScripts, 131
with Automator, 512
basics of, 507
displaying Script menu, 508
example Scripts folder, opening, 509
opening from Scripts menu, 511
ready-make AppleScripts, using, 508-509
recording, 510
Script Assistant, 508, 510-511
templates, starting new, 510
writing, 510

AppleTalk printers, installing, 198-199
applications, 1, 127. See also aliases; third-

party applications
different program, opening documents

with, 29
full-screen, using, 135
icons, 10
Info window, information in, 50-51
installing third-party applications, 129a
launching, 132

list of, 131
nonresponding, quitting, 138
opening, 134
quitting, 138
showing/hiding, 136
Spotlight searches, keywords for, 57
switching between, 136-137
System Information, viewing system

information with, 447
Application Services, using, 436
Applications folder, 26-27
App Store, 131

Apple Push Notification, 128
buy and download apps, 128-129
install apps, 128-129
using with Launchpad, 132

archiving. See also backing up
Address Book data, 141
Create Archive command, 435
e-mail, 281

ARPANET (Advanced Research Projects
Agency Network), 217

Arrange By button and menu, 32
arrows in dialogs, 9
Assist Me, help with, 407
attachments

deleting from e-mail, 277
iCal calendar event attachments, work-

ing with, 372
with instant messages, 303
in replies to e-mail, 275
saving files, 277
sending files as, 276
Spotlight results as, 63
viewing, 276-277

audio chats. See iChat
audio MIDI devices, configuring, 462-463
authentication preferences for Bluetooth,

415
AutoFill for Safari forms, 242
Automator, 131, 491

Action list, 492, 494
actions, 491

adding, 500
recording actions, 502
variables to action, adding, 501

AppleScripts with, 512
Description view, 493, 494
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example workflow
modifying, 499
opening, 497
working with, 498

existing workflow, opening, 496
input and output, controlling, 499
introduction to, 492-493
Library pane, 492, 494
modifying example workflow, 499
plug-ins with, 499, 506
printing workflow, 505
recording actions, 502
running and saving workflows, 504-505
Search box, 493, 494
starting, 495
stopping workflow, 504
toolbars, 492, 494

customizing, 505
Variable list, 492-493, 494
variables to action, adding, 501
Watch Me Do action, 502
window, parts of, 492-494
Workflow log and panes, 493, 494
Workflow variable list, 493, 494
working with workflows, 503

autosaving TextEdit preferences, 194
Auto Save, 152

duplicating document, 152
locking/unlocking documents, 152
reverting to last saved, 152
using with 

Automator, 505
Preview, 150-151
TextEdit, 190-191

B
Back button on toolbar, 17
backdrops in Photo Booth, 335
backgrounds

desktop backgrounds, selecting, 100
in e-mail message text, 269
iChat window background, changing, 311

backing up, 477. See also archiving; disk
image; Time Machine

on CDs or DVDs, 490
compressed files and folders, 435
e-mail, 281

formatting, backups prior to, 438
iCal calendar, 373
to iDisk, 479
iTunes library, 331
MobileMe, backing up files, 362-363

Back to My Mac, accessing computer with,
420

baseline for characters, changing, 182
BBEdit, 436
BinHex format, 251
birthday calendars, 371

Address Book, 142-143
blocking

e-mail, 284-285
iChat buddies, 302
pop-up windows, 255

Bluetooth.
Application Services with, 436
desktop icon, 5
with Mac for Windows, 465, 472-473
making Internet connection with, 224
moving items with, 414
Passkey with, 413
preferences, setting, 415
printers, installing, 199
setting up network, 412-413
sharing, 405

boldfacing
document text, 178
e-mail message text, 269
fonts, 155

Bonjour, 289
list of Web sites, viewing, 238
printers

installing, 198-199
sharing, 202-203

problems with, 308
saving chats, 311
starting messaging, 309
turning on, 308

bookmarks. See also Safari
with DVD Player, 337

Bookmarks Library. See Safari
Boolean operators with Spotlight search, 57
Boot Camp Assistant, 110, 465. See also

Mac for Windows
installing Windows on Mac, 468-469
preparing Mac for Windows, 466-467
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Boot Camp Assistant (continued)
removing Windows with, 474-475
upgrading from beta, 467

BOOTP (boot protocol), 221
borders for table cells, 185
bouncing e-mail, 284-285
Braille, VoiceOver supporting, 120, 123
brightness on monitor, changing, 456
broadband connection. See cable modems
browsers. See Web browsers
buddies. See iChat
bulleted lists, 184

in e-mail message text, 269
burning. See CDs; DVDs
Business, Dashboard displaying, 158-159
.bzip files, opening, 434

C
cable modems, 218

Ethernet with, 221
firewalls for, 409
sharing connection, 408

cache
for e-mail, 260
Safari cache, emptying, 236

calculations. See also Calculator
Calculator, 131

conversions, performing, 146-147
Dashboard displaying, 158-159
working with, 146

CalDAV 
setting up accounts, 258
workplace calendar server, 374-375

CardDAV 
Address Book, 144-145
setting up accounts, 258

calendars. See iCal
cards. See also vCards
case-sensitivity

for finding/replacing text, 176
of passwords, 3

CD-ROMs, 27
CD-Rs, 27
CD-RWs, 27, 52
CDs. See also iTunes

adding/removing files/folders from, 53
backing up files on, burning, 490

creating, 53
disk image, burning from, 488
erasing, 329
music CDs, burning, 330
preparing to burn, 52
Sidebar, burning disk with, 16
start settings, changing, 111
System Information, viewing informa-

tion with, 447
uneven CDs, loading, 27

Cellos voice, 116
cell phones.

Bluetooth preferences, setting, 415
iPhones with iTunes, 327

cells in tables, 184-185
center-alignment

of document text, 178
of tables, 184

change of address notification, 140
characters

baseline, changing, 182
for file names, 42
spacing, changing, 182
special characters, inserting, 188

check boxes in dialogs, 9
check marks in menus, 7
Chess, 127, 139
children. See parental controls
Chinese handwriting, 169
cleaning up

files and folders set by clean up, 33
Icons view, items in, 32-33

clicking with mouse, 6
Clipboard

document text on, 166-167
Web page text, copying, 249

Close button for windows, 12
closed captioning in QuickTime Player, 339
closing

dialog options, 9
documents, 191
windows, 12-13

CloudApp. See also iCloud
CloudApp menu, 344-345
drops, working with, 347
introduction, 343
joining, sign in, 344-345
preferences, 349
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raindrops, 348
sharing files, 346-347
sign out, 345
uploading, picture, 189
Web App, using, 350-351

collating print output, 206
color labels

for files and folders, 40-41
for Find window searches, 67
names, changing, 41

Color Picker, selecting with, 459
colors. See also ColorSync

Color Picker, selecting with, 459
Digital Color meter, using, 458
for document text, 178
with DVD Player, 337
for e-mail message text, 269
for fonts, 155
highlight colors, changing, 98
for iChat chats, 310
for instant message text, 300-301
monitor options, 456
palettes, selecting, 459-460
printer speed and, 196
printing, matching for, 207
for quoted text, 274
of Sticky Notes, 153

ColorSync
for fax documents, 215
matching colors to device with, 460-461
for printed documents, 207

columns. See also List view; tables
windows, headings for, 12

Columns view, 30
customizing window views, 80-81
keyboard options in, 37
Preview column, 37
viewing folders in, 37

Comic Book effect, 335
commands, 7. See also specific commands

Startup commands, 395, 399
VoiceOver commands, 124-125

comments
Info window options, 51
in Keychain, 382

compatibility of hardware devices, 464

compressing/uncompressing
attachments, files for, 276
compressed files, 435
downloaded applications, 129a
files and folders, 33
restoring compressed files, 435
Safari, disk images in, 251
Stuffit Expander, opening compressed

files with, 33, 129a, 434
computers. See also networks

Find window searching, 66
iTunes, authorizing/deauthorizing, 316
local name, changing, 405
maintaining, 431
several computers, connecting, 418-419
stand-alone computers, starting on, 2

Console utility, viewing system messages
with, 446

contacts. See Address Book
contents, Find window searches by, 67
contextual menus, 8
conversions with Calculator, performing,

146-147
cookies, 254

deleting, 256
cool genie effect, 87
copies for printing, 206
Copy command, 44
copying. See also drag-and-drop

Automator workflows, 503
documents, text in, 167
with Exposé, 45
files and folders, 44-45
Find window files, 69
formatting, 187
hard disk, 439
icons, 10-11
ruler, 179
Sidebar, copying folders with, 16
Web page text, 249
Windows and Mac OS X, files between,

472-473
copyrights

documents, inserting in symbol in, 188
iTunes and, 323
spacing for symbol, 182
Web page text, copying, 249

Corel WordPerfect Page Setup, 204-205
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Cover Flow, 30
customizing window views, 80-81
iTunes, working with music in, 319
viewing files in, 36

cover pages, creating, 207, 211
CPU activity, viewing, 445
Create Archive command, 435
credit cards

for iTunes Music Store, 319-320
CSS, 162
currency conversions, calculating, 146-147
Customize Toolbar dialog, 82-83
customizing

Automator toolbars, 505
Dock, 86-87
DVD Player, 337
Exposé, 90
fonts, 155
keyboard shortcuts, 453
QuickTime Player, 338-339
RSS feeds, 240
Safari window, 226
Sidebar, 84-85
Spaces, 91
views, 30
widgets, 161

Cut command, 44

D
Dashboard, 131

deleting widgets, 160-161
full-screen app, using, 135
installing widgets, 160
preferences, changing, 157
pre-installed widgets, using, 158-159
showing/hiding widgets on, 158
Web Clip widget, creating, 162
working with, 156

Dashcode, 162
data detector, 171
dates and times

announcing, 103
files and folders arranged by, 33
international options, changing, 104-105
menu bar clock, using, 103
setting, 102-103
showing, 103

Spotlight searches, keywords for, 57
time zones, setting, 102
World Clock, displaying, 158-159

deleting. See also Dock; iChat; Mail; Safari
Address Book contacts, 142-143
aliases, 88
attachments from e-mail, 277
Automator workflows, 503
Dashboard widgets, 161
documents, text in, 166
downloaded file, 251
e-mail, 280-281
files and folders, 48
hardware devices, 464
iCal events, 372
Keychain names, 381
List view, columns in, 35
printers, 198-199
print queue, job from, 210
recently used documents, 165
Safari History list entries, 236
securely deleting files and folders, 49
stacks from Dock, 19
third-party preferences, 95
toolbar icons, 83
user accounts, 389

Description view on Automator, 493, 494
design themes, 5
desktop. See also icons

backgrounds, selecting, 100
introduction to, 4-5
screen, 2

Desktop folder, 28-29
desktop printers, using, 207
Development menu, Safari, 253
Devices section, Sidebar, 16
DHCP (Dynamic Host Configuration

Protocol), 221
dialogs

closing options, 9
language options, setting, 104-105
navigating in, 9

dial-up connections, 220
Dictionary, 131, 163. See also spell and

grammar checking
adding words to, 172
AppleScript dictionary, Automator, 512
Dashboard displaying, 158-159
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looking up words with, 174
parental controls, setting, 175
preferences, setting, 174-175
recent searches, viewing, 175

Digital 8 camcorders with iMovie, 342
digital cameras. See Image Capture; iPhoto
digital certificates with Keychain, 381
Digital Color meter, 458
digital hub, cloud, 367
Digital Video (DV) camcorders, 291
Directory, 131

Address Book information, sharing, 145
disabled persons. See Universal Access
disk file system, 437

activities, monitoring, 444-445
Console, viewing system messages with,

446-447
copying disk, 439
formatting disks, 438
optimizing disk, 441
problems, fixing, 440
System Information, viewing system

information with, 447
disk image

blank disk image as backup, 487
burning CD/DVD from, 488
creating, 486-487
restoring to disk, 489

disks. See also disk file system; hard drive
ejecting disks, 54
mounting disks, 54
opening/viewing, 26-27

Disk Utility, 52. See also backing up; disk
file system

copying disk, 439
formatting disks, 438
restoring disk images with, 489
Windows, removing, 474-475

.dmg file format, 434
DNS (Domain Name Server), 218

for modems, 220
Dock, 5. See also showing/hiding

aliases on, 88-89
applications, launching, 132-133
customizing, 86-87
deleting

items, 87
stacks, 19

Launchpad, using, 132-133
moving items from, 87
showing/hiding, 86

hidden Dock, displaying, 18
stacks, 19

Simple Finder, 92
stacks, 19

documents, 163. See also attachments;
Dictionary; faxing; HTML 

bulleted lists, adding, 184
character spacing, changing, 182
closing, 191
copying text, 167
corrections in, 170
creating, 164
deleting text, 166
different program, opening with, 29
editing text, 166-167
existing documents, opening, 165
file formats for, 164
files, adding, 189
finding/replacing text in, 176-177
formatting

copying/pasting, 187
text, 178

grammar-checking, 172-173
handwritten text, inserting, 168-169
hyphenation, setting, 181
icons, 10
images, adding, 189
inserting text, 166
line spacing, changing, 183
lists, adding, 184
Microsoft Word file, saving as, 164, 190
movies, adding, 189
moving text, 167
numbered lists, adding, 184
opening, 28-29
page breaks, inserting and deleting, 183
Page Setup options for, 204
paragraph indents, setting, 181
paragraph tabs, setting, 180
PDF files, saving as, 209
Plain Text files, saving as, 190-191
previewing printed documents, 208
protecting, 190
read-only files, saving documents, 190
recent documents, opening, 165
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documents (continued)
RTF file, saving document as, 164, 190
rulers, using, 179
selecting text in, 166
spacing

character spacing, changing, 182
line spacing, changing, 183

speaking text in, 175
special characters, inserting, 188
spell-checking, 172-173
styles, applying, 186-187
tables, adding, 184-185
text wrap, changing, 181
typing errors, correcting, 170
undoing/redoing actions in, 170
viewing, 28-29
Web page, opening, 228-229

Documents folder, 28-29
dots per inch (dpi), 196
double-clicking with mouse, 6
downloading. See also iTunes; Safari

Acrobat Reader, 209
deleting downloaded file, 251
disk images, 251
iChat versions, 291
installing downloaded applications, 129a
MobileMe services backup, 362
printer drivers, 197
software, 432
stopping downloading of file, 251
widgets, 156

Downloads folder, 28-29
Downloads window

clearing settings, 256
working with files in, 250-251

dpi (dots per inch), 196
drag-and-drop

document text, moving/copying, 167
files and folders, copying/moving, 45

dragging
aliases, 89
with mouse, 6

drivers for printers, 197
Drop Box folder in Home folder, 47, 402
DSL (digital subscriber line), 218

Ethernet with, 221
sharing connection, 408

DVD Player, 131, 315
browsing movies with, 328
customizing, 337
key points, creating, 337
playing movies with, 328

DVD-R and DVD-RWs, 27, 52
DVDs, 27. See also iDVD

adding/removing files/folders from, 53
backing up files on, 490
creating, 53
disk image, burning from, 488
erasing, 329
preparing to burn, 52
start settings, changing, 111
System Information, viewing informa-

tion with, 447
uneven DVDs, loading, 27

E
editing

Address Book contact information, 142-
143

color labels, 40
documents, text in, 166
keychains, 382-383
Smart folders, 70-71

Edit menu Undo/Redo commands, 43
editing movies, 340-341
ejecting disks, 16, 54

desktop icon, 5
ellipses (...)

full text, showing, 34
in menus, 7

e-mail. See also Mail
MobileMe mail, 354

embedding movies and images, 189
emoticons in instant messages, 300-301
empty Trash warning, turning on/off, 49, 79
encryption

FireVault using, 400
Recovery key, password, 398-399
Keychain data, 384

entry fields in dialogs, 9
EPS (Encapsulated PostScript) files, 150
erasing CDs/DVDs, 329
Esc key, 9
ESPN, Dashboard displaying, 158-159



Index 535

Ethernet. See also AirPort
configuring connection, 218
for LANs, 410
networks, 218
setting up connection, 221

Eudora mail, importing, 259
example workflow. See Automator
exporting. See importing/exporting
Exposé. See also Mission Control

copying items with, 45
customizing, 90
Dashboard preferences, changing, 157
moving and copying files with, 45
using with Mission Control, 20-21
space with, 21

extensions, Safari, 252
external disks, 27

F
Facebook

Address Book, 142-143

QuickTime, 340-341

Safari extension, 252-253
FaceTime, 131

Address Book, 142-143
preferences, 313
starting, 313
using with Preview, 150-151
video call with iPad, iPod touch or 

Mac, 313-314
Fast User Switching, enabling, 396
favorites

folder, 29
style favorites, applying, 186-187

faxing, 195
Address Book, addressing faxes from,

214
automatically receiving faxes, 216
cover pages, creating, 207, 211
receiving faxes, 216
scheduling faxes, 215
sending fax documents, 214-215
sleep mode, turning off, 216
status of fax, checking, 215

Feedback window for speech recognition,
114-115

file extensions

different program, opening documents
with, 29

for document files, 164
Find window searching, 66
renaming files, effect of, 43
showing/hiding, 79

File Info window, 390
file management, 25
file permissions

for copying and moving files, 45
setting, 390

files, 1. See also aliases; Exposé; file 
permissions; Home folder; iDisk;
naming/renaming

arranging files, options for, 33
Bluetooth, moving with, 414
colors, organization by, 40
Columns view, working in, 37
compressing, 33
copying, 44-45
Cover Flow, viewing with, 36
deleting, 48
documents, adding to, 189
e-mail as file, saving, 282
Icons view, viewing in, 32-33
Info window, information in, 50-51
instant messages, sending with, 303
kind

arrangement of files by, 33
Find window search for files by, 67

List view, working in, 34-35
moving, 44-45
Network Sharing Services, 404, 406-407
Quick Look, viewing in, 38
recently used files, opening, 134
restoring deleted files, 48-49
sorting by column, 35
Stationery Pad, 50-51

FileVault
computer, protecting, 400
passwords with, 400
Recovery key, password, 398-399
turning on/off, 400

File Transfers manager in iChat, 303
filters. See also Quartz Filters

Spotlight results, filtering, 60
viewing information on, 461

Final Cut Pro, 338-339
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Finder, 1. See also CDs; DVDs; Finder
Preferences; indexing

Application Services with, 436
Automator workflow from, 506
Help menu, 72
icons view, customizing, 80
introduction to, 4-5
mouse pointer in, 6
networks, browsing, 416-417
Simple Finder, 92
Spotlight results in, 63
toolbar, customizing, 82-83
undoing actions in, 43
window opening, customizing, 78

Finder Preferences, 26, 75
Advanced preferences pane, 76
description of, 76
file extensions, showing/hiding, 79
General preferences pane, 76
icons on desktop, specifying, 77
Label preferences pane, 76
Sidebar preferences pane, 76
spring-loaded folders, turning on/off, 46

finding/replacing
documents, text in, 176-177
Wrap Around option, 176-177

Find window
files, searching for, 66-67
hard to find information, searching 

for, 68
naming/renaming

files, 69
searches by name, 67

results, working with, 69
Finger service, 430
firewalls, 219

configuring, 409
printers, sharing, 202-203

FireWire, 54
FireVault protecting, 400

flash drives, 27

Flickr, Quicktime, 340-341
Flight tracker, Dashboard display, 158-159
folders, 25. See also aliases; Exposé; iDisk;

naming/renaming; Smart folders;
spring-loaded folders

arranging folders, options for, 33
Automator workflow from, 506

bookmarks folder, creating, 238
colors, organization by, 40

folders
Columns view, working in, 37
compressing, 33
copying, 44-45
creating, 42
deleting, 48
icons, 10
Icons view, viewing in, 32-33
Info window, information in, 50-51
kind

arrangement of files by, 33
Find window search for files by, 67

List view, working in, 34-35
moving, 44-45
Quick Look, viewing in, 38
Recent Folders list, 39
restoring deleted folders, 48-49
Safari bookmarks, creating folder, 238
sorting by column, 35
Spotlight searches, keywords for, 57
types of, 26-27

Font Book, 127, 131
activating/deactivating fonts, 155
managing fonts with, 154

fonts
defined, 178
for document text, 178
for e-mail message text, 269
for iChat chats, 310
for instant message text, 300-301
locating, 155
on-screen smoothing, 457
Safari font preferences, setting, 253
size, 178
smoothing styles, changing, 98-99
Spotlight searches, keywords for, 57
TextEdit preferences, setting, 194

forcing a restart, 448
foreign languages. See languages
formatting. See also documents

copying/pasting, 187
disks, 438
e-mail message text, 269
instant message text, 300-301
international options, changing, 104-105
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TextEdit preferences, setting, 194
forms, filling out, 242-243
Forward button on toolbar, 17
forwarding e-mail, 274-275
frames, 225

printing Web page frame, 246
full-screen

apps, using, 135
interface with DVD Player, 337
Safari, using, 226, 227

G
general preferences, changing, 98-99
gestures for ink

Ink Pad recognizing, 169
turning on/off, 126

gestures for trackpad, 6
Get Info button, 69
Get Info dialog box, 63
G5 architecture, 464
Gmail calendar account, 368
Go menu, 39
Google

Address Book from, 142-143
Application Services with, 436
clearing search settings, 256
Dashboard displaying, 158-159
iCal calendar account, 368
iChat, Google Talk with, 289, 290
Search box, 244-245
setting up accounts, 258

Gmail
setting up accounts, 258, 260-261

Grab, 436
screen shots, capturing, 149

Gracenote music title repository, 331
grammar checking. See spell and grammar

checking
graphics. See also images

Quartz Extreme enhanced graphics, 100
RTFD files for, 164

grid settings, overriding, 33
grouping/ungrouping

iCal, creating calendar groups, 370-371
iChat buddy groups, managing, 298-299
Spotlight results, 62

GUI (graphic user interface), 1, 454
.gzip files, 251
opening, 434

H
hackers, firewalls and, 409
handwriting

documents, inserting handwritten text
in, 168-169

Chinese, in, 169
ink preferences, setting, 126

hard drive, 27. See also disk file system
Find window searching, 66
FireVault protecting, 400
Info window, information in, 50-51
optimizing, 441
Recovery key, password, 398-399
System Information, viewing informa-

tion with, 447
Web page, opening, 228-229

hard to find information, searching for, 68
hardware, 449

Apple Hardware Test, 450
ColorSync, matching colors to device

with, 460-461
compatibility, checking for, 464
installing devices, 450
for Mac for Windows, 466
preferences, 94

viewing, 452
problems, preventing, 464
removing devices, 451
Safe boot, performing, 464
settings, viewing, 452

hearing impaired users, preferences, 118
help

Assist Me, help with, 407
browsing for, 72-73
for iChat, 72, 292
for Internet connection, 219
searching for, 72-73
with Spotlight, 74
VoiceOver help, 121

hexadecimal color values, 458
highlight colors, 98
History list. See Safari
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Home folder, 28-29, 388
desktop, opening from, 29
Drop Box folder, 47, 402
Find window searching, 66
managing files with, 401
Public folder, 28-29, 47, 402
Shared folder, 47, 402

Home page. See Safari
hot spots, VoiceOver, 121, 124
HTML (Hypertext Markup Language)

Dashcode, 162
documents in, 164
links to HTML files, adding, 193
opening HTML documents, 192
plain HTML code files, creating, 192-193
TextEdit, creating HTML documents

with, 192-193
Web page code, viewing, 248

HTTP (Hyper-Text Transfer Protocol), 229
hubs for LANs, 410
hyperlinks. See links
hyphenation, setting, 181

I
iBook sleeping options, 109
iCal, 131. 

adding calendar accounts, 368
adding calendar events, 372
attachments for event, working with, 372
Automator workflow from, 506
backing up calendar, 373
creating calendars with, 370-371
Dashboard displaying, 158-159
deleting events, 372
details of event, editing, 373
editing calendar events, 372-373
full-screen app, using, 135, 368-369
groups in calendar, creating, 370-371
importing/exporting events, 372
preferences, changing, 371
printing calendar and Reminder lists, 377
publishing calendar, 374
reminders

creating, 376
printing, 377

restoring calendar, 373
shared calendars, finding, 374

Spotlight searches, keywords for, 57
subscribing to calendar, 374-375
view, changing, 369
viewing window, 368

iChat, 127, 131, 289, 343. See also Bonjour
accounts, creating, 258, 290-291
adding buddies, 296
with AirPort, 308
alerts, setting, 312
animated GIF, creating, 297
appearance of chat, changing, 310
Application Services with, 436
audio chats, 304

enhancing, 306
automatically reopening chats, 311
away messages, 294
backdrops, adding, 306
background of window, changing, 311
bandwidth speed for video chats, 

changing, 304-305
blocking buddies, 302
collecting chats in single window, 301
custom status messages, creating, 294
deleting

buddies, 296
groups of buddies, 299

downloading versions of, 291
e-mail, responding to, 274
emoticons, inserting, 300-301
files with message, sending, 303
formatting message text, 300-301
full-screen app, using, 135
groups of buddies, managing, 298-299
help in, 72, 292
links with messages, sending, 303
notification alerts, 312
parental controls for, 392-393
passwords for, 291
performance and quality specs, 305
Photo Booth

effects, adding, 306
video clips in, 334

pictures
of buddies, 297
theater presentations, 306-307
of video chats, 305

receiving instant messages, 300
recording video chats, 307
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renaming buddy groups, 299
searching for buddies, 298-299
sending instant messages, 300
sharing screens, 309
signing in and out, starting, 292
status, changing, 294
Status menu, using, 294-295
Tab bar, 300-301
text, viewing chat as, 311
theater presentations, hosting, 306-307
turning on/off

groups, use of, 298
Status menu, 295

video chats, 304
backdrops, adding, 306
bandwidth speed, changing, 304-305
enhancing, 306
installing hardware for, 291
monitoring, 305
Photo Book effects, adding, 306
pictures of, 305
recording, 307
theater presentations, 306-307

viewing window, 293
view of buddy list, changing, 299

iCloud. See also CloudApp
CloudApp menu, 344-345
introduction, 343
joining, sign in, 344-345
sign out, 345

icons. See alsoTrash
copying, 10-11
customizing views of, 80-81
deselecting, 10-11
on desktop, 4
disk icons, displaying, 27
Finder Preferences for displaying, 77
moving, 10-11
selecting, 10
Sidebar, removing icon from, 16
for Spotlight, 55

Icons view, 30
arranging items in, 32-33
customizing window views, 80-81
spring-loaded folders, opening, 46

iDisk, 16, 343
backing up files to, 479

displaying files from, 363
managing files with, 362
passwords, changing, 365
preferences, setting, 364-365
Public folder, 363, 366

permissions, changing, 366
sharing, 366

iDVD, 52
exploring, 342

iListen, 116
Image Bar with DVD Player, 337
Image Capture, 131

Automator workflow from, 506
working with, 148

images. See also attachments
Address Book, adding images to, 142
documents, adding to, 189
iChat buddy picture, changing, 297
previewing, 150-151
Safari, saving Web page images in, 249
Spotlight searches, keywords for, 57

IMAP (Internet Messages Access Protocol),
261

mailboxes for, 279
iMovie, 342
Import Bookmarks command, 237
Import Image command, 436
importing/exporting. See also iTunes

Address Book contacts, importing, 141
from Yahoo! Address Book, 141

animated GIF, exporting movie as, 335
Automator workflows, 503
iCal events, 372
iTunes, music from CDs to, 319
mailboxes to Mail, 259
MP3 players, exporting music to, 330
QuickTime, exporting movies, 340-341

Inbox. See Mail
indents

documents, 181
for e-mail message text, 269

indexing, 55
Info window options, 51
search, files for, 67

Info window
file information on, 50-51
options, setting, 51
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infrared (IR) technology, 223, 315
ink-jet printers, 196
Ink Pad, 168
ink preferences, setting, 126
installing. See also uninstalling

Dashboard widgets, 160
hardware devices, 450
printers, 198
software, 432
third-party applications, 129a
Windows on Mac, 468-469

instant messages, 289. See also Bonjour;
iChat

SMS (short message service) text, 308
Intel-based Mac computers. See Mac for

Windows
inter-line spacing, 183
international options, changing, 104-105
Internet, 217. See also AirPort; downloading;

firewalls; wireless connections
Assist Me button, 219
connecting to, 218-219
hardware problems, checking on, 464
history of, 217
modems, setting up, 220
multiple connections, 219, 223
parental controls for, 392-393
searching, 244-245
security, 219
sharing connections, 219, 405, 408
songs, finding names of, 331
status menus for connecting to, 224

Internet Explorer, 217
Internet Radio, 315

iTunes window settings, 317
listening to, 328

iPhones with iTunes, 327
iPhoto, 52.
Automator example workflow for, 497

description of, 342
e-mail, adding photos to, 268

IP (Internet Protocol). See also printers
identifying address, 419
for ISPs (Internet service providers), 218
Sharing Service requiring, 404

iPad
synching with Address Book, 144-145

iPhone
syncing with Address Book, 144-145

iPhoto
getting pictures for Address Book, 142
getting pictures for iChat, 297

iPod touch
Automator example workflow for, 497
disks, 27
synching with Address Book, 144-145
with iTunes, 315, 327
unmounting, 54

iSight, 127, 291. See also Photo Booth
with Mac for Windows, 465, 472
using with Preview, 150-151

ISPs (Internet service providers), 218
attachments and, 276
Safari preferences, setting, 253

italicizing
document text, 178
e-mail message text, 269
fonts, 155

iTunes, 52, 131, 315.
Address Book, 144-145
aspects of iTunes, viewing, 321
automatically playing CDs with, 318
backing up library, 331
Boot Camp Assistant and, 465
copyright laws and, 323
Dashboard displaying, 158-159
downloading

from CDs, 319
from iTunes Music Store, 320-321

Genius playlist, 324
iMix, creating, 323
importing/exporting

CDs, music from, 319
MP3 players, exporting music to, 330
playlists, 322, 324

iPhones with, 327
iPods with, 327
with Mac for Windows, 472
minimizing window, 321
multiple libraries, creating, 319
Ping, 325
playing music from CDs, 319
playlists

burning music CDs from, 330
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creating, importing/exporting, 322-324
media, adding, 324
Smart Playlists, building, 322-323

podcasts, listening to, 326
preferences, setting, 332
radio list, adding stations to, 328
setting up, 316
Smart Playlists, building, 322-323
starting, 316
viewing window, 317
volume control for, 112

iTunes Mini Store, 316
iTunes Music Store, 317

iMix, creating, 323
using, 320-321

iWork, in Preview, 150-151

J
Jabber and iChat, 289, 290
Java, Safari enabling, 254
JavaScript

Dashcode, 162
Safari, enabling in, 254

joining iCloud community, 343, 344-345
Junior voice, 116
junk e-mail, 284-285
justification

of document text, 178
of tables, 185

K
kerning, changing, 182
keyboards

Calculator, using with, 146
changing settings, 453
international options, changing, 104-105
with Mac for Windows, 465, 472-473
Universal Access options, 118-119
VoiceOver help, 124

keyboard shortcuts, 7
applications, switching between, 137
customizing, 453
with DVD Player, 337
for Exposé, 90
Spotlight, setting for, 64-65
turning on, 9
with VoiceOver, 124

Keyboard Viewer, 104-105
Keychain

access controls, setting, 383
adding keychains, 384
description of, 380
modifying, saving keychains, 382-383
working with, 381

keywords
for Find window searches, 67
for Internet searches, 244
for Spotlight searches, 57

kilometer to miles conversions, 146-147

L
labels. See also color labels

Address Book labels, 140, 143
files and folders arranged by, 33

landscape orientation printing, 205, 206
languages

dictionary sources, 174
in documents, 165
Info window options, 51
international options, changing, 104-105

LANs (local area networks). See also AirPort
Ethernet connection for, 221
iChat with, 308
setting up, 410
with Sharing Service, 404
Windows Vista computers, connecting

from, 425
Windows XP computers, connecting

from, 426-427
laser printers, 196
Launchpad

adding or removing apps, 132
using folders, 132-133
using with App Store, 128-129

layout
for fax documents, 215
for printing, 207

LDAP (Lightweight Directory Access
Protocol) 

Address Book, 144-145
setting up accounts, 258

left-alignment
of document text, 178
of tables, 184

left indent marker, 181



542

libraries. See iTunes
Library folder, 26-29
Library pane on Automator window, 492
Light Tunnel effect, 335
line height/spacing, changing, 183
links

e-mail message, sending links in, 276
to HTML code files, 193
instant messages, sending with, 303

lists. See bulleted lists; numbered lists
List view, 30

color labels, sorting files and folders, 40
customizing window views, 80-81
rearranging, widening columns in, 35
showing/hiding folders in, 34
sorting files and folders in, 35-36
spring-loaded folders, opening, 46

local disk, 27
location services, 397
locking/unlocking preferences, 97
logging in, 1

items, specifying, 394
with Network Sharing Services, 405

logging out, 23
Login window, 2

actions from, 3
activating, 387
bypassing, 3

lowering characters, 182
LTP Over IPsec protocol, 428

M
MacBinary format, 251
MacBook OS X DVD, keeping, 399
Mac Finder. See Finder
Mac for Windows, 465. See also Boot Camp

Assistant
installing Windows on Mac, 468-469
Migration Assistant

between Mac and PC, 443
multiple internal disks, removing

Windows from computer with, 474
preparing, 466-467
removing Windows, 474-475
starting after installation of, 470-471
using Windows on Mac, 472-473

Mac OS X, 478
applications, list of, 131
CD, restoring passwords with, 399
Migration Assistant, 443
OS X DVD, keeping, 399
restarting with, 110
Time Machine for reverting to previous

version, 484-485
Server account, creating, 258
Windows files, copying, 472-473

Magic Mouse. See Apple Magic Mouse
Magic Trackpad, 6, 33, 132
Mail, 131, 257. See also Address Book;

attachments
accounts

adding, 261
advanced options, setting, 263
managing, 262-263
setting up, 259, 260

addressing e-mail, 266-267
advanced account options, setting, 263
Application Services with, 436
archiving e-mail, 281
authentication of, 263
backing up e-mail, 281
BCc address field, 265
blocking e-mail, 284-285
bouncing e-mail, 284-285
Cc field, 266
composing e-mail, 265
conversation, organized by, 278-279
data detectors, managing information

with, 268
dates and times, setting, 102
deleting, 280-281

options, changing, 281
diverting incoming e-mail to mailboxes,

285
draft e-mail, saving, 282
Exchange, Microsoft, support, 258, 

260-261
Favorites bar, 271
file, saving e-mail as, 282
flagging, color-coded, 283-284
formatting message text, 269
forwarding e-mail, 274-275
full-screen app, using, 135, 271
grammar-checking e-mail, 265
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importing mailboxes and e-mail, 259
incoming e-mail, setting rules for, 286
instant message, replying to e-mail with,

274
junk e-mail options, 284-285
links in e-mail message, sending, 276
mailboxes

for backing up e-mail, 281
diverting incoming e-mail to, 285
new mailbox, creating, 278
organizing e-mail in, 279
Smart Mailbox, creating, 287
standard mailboxes, 278

Message List view, changing, 271, 273
new e-mail, checking for, 272
new mailbox, creating, 278
notes

creating, 267
searching for, 283

offline viewing, keeping copies for, 263
opening e-mail, 272-273
Out of Office message, creating, 286
parental controls for, 392-393
passwords for, 259, 263
photographs, adding, 268
preferences for addressing, 266-267
previous recipients list, sending e-mail

with, 266-267
printing e-mail, 281
priority to mail, adding, 265
quoted text in, 274
reading and receiving e-mail, 272-273
recovering deleted e-mail, 280
redirecting e-mail, 274-275
replying to, 274
resending messages, 285
RSS feeds, subscribing to, 288
rules, creating, 286
saving e-mail, 282
searching e-mail for text, 283
sending e-mail, 265
servers, 260-261

removing mail from, 263
signatures, creating, 270
Smart Addresses, using, 266
Smart Mailbox, creating, 287
sorting messages, 279
speaking voice, adding, 268

spell-checking e-mail, 265
Spotlight searches, keywords for, 57
starting, 259
stationery, adding, 268
threads, sorting e-mail by, 279
to-do tasks

searching for, 283
tracking, 267

Trash mailbox, 278
window, viewing, 264

maintaining computer, 431
master password, restoring, 398-399
maximizing/minimizing

changing options, 98
Dock, 86
iTunes window, minimizing, 321
slowing minimization, 87

me card, Address Book, 141
media

iTunes playlists, adding to, 322, 324
Media browser for Automator workflows,

503
memory

calculation results, saving, 147
Info window options, 51
system memory, viewing, 445

menu bar, 5
Bluetooth placed on, 413
clock, using, 103
Displays icon on, 456
rearranging status icons on, 8
status of fax, showing, 215, 216

menus
contextual menus, 8
language options, setting, 104-105
pull-down menus, 8
working with, 7

metadata, 55
specific metadata, searching for, 68
Spotlight, finding information with, 56

microphones with iChat, 304
Microsoft. See also Mac for Windows;

Microsoft Word; Windows 7 or Vista;
Windows XP

Excel, Address Book for faxes with, 214
Exchange 2007, 2010 or later

Address book, 144-145
calendar, 368
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Microsoft (continued)
Mail, Contacts & Calendar, 258
Mail server, 258, 260-261

Internet Explorer, 217, 225
Office documents, in Preview, 150-151
Outlook/Outlook Express, importing 

e-mail to, 259
Microsoft Word

Address Book for faxes with, 214
documents as files, 164, 190
formatting text in documents, 178
opening documents in, 29
Page Setup options, 204-205

MIDI
devices, configuring, 462-463

Migration Assistant
between Mac and PC, 443

MiniDV camcorders with iMovie, 342
Minimize button for windows, 12, 15
mini restarts, 448
Mission Control, 131

copying items with, 45
customizing, 90-91
customizing with Dashboard, 157
moving and copying files with, 45
using 20-21

MobileMe, 343. See also iDisk
accessing account, 352
Address Book, 144-145, 355
backing up files with, 362-363
calendar, adding, 356

events, 357
preferences, 357

connecting to computer with, 420
e-mail, managing, 354
gallery, 358-361

creating and modifying, 358-359
viewing and sharing, 360-361

iDisk, sharing, 366
joining MobileMe community, 352
Mail services, 354
preferences for account, changing, 

352-353
setting up accounts, 258, 260-261
signing on to, 352

MobileMe synchronization
resetting, 379
setting up, 378

modems, 218. See also cable modems
configuring connection, 218
setting up connection, 220

monitors. See also colors
display settings, changing, 456-457
fonts on screen, smoothing, 457

mounting disks, 54
mouse. See also Apple Magic Mouse

changing settings, 454
pointer, 6
Universal Access options, 118-119
windows, resizing, 15
working with, 6

Mouse Keys, 118-119
movies. See videos
Movies folder, 28-29
moving. See also drag-and-drop; navigating

Address Book contacts, 142
Bluetooth, items with, 414
Dock items, 87
documents, text in, 167
with Exposé, 45
files and folders, 44-45
icons, 10-11
Mailboxes on screen, 279
Safari, bookmarks in, 237
Sidebar, moving folders with, 16
spaces, window between, 21
windows, 14

MP3 players, exporting music to, 330-331
MR (Memory Recall) button, 147
multi-function devices, 196
Multi-Touch gestures, 6, 33, 132
music, 315. See also CDs; iTunes; MIDI

finding names of songs, 331
Spotlight searches, keywords for, 57

Music folder, 28-29
muting sounds, 112
me card, Address Book, 141

N
naming/renaming. See also Find window;

Keychain
color label names, changing, 41
files and folders, 42-43

arranging by names, 33
iChat buddy groups, 299
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Info window options, 51
Mailboxes, 279
Safari Bookmarks Library collection, 239
user accounts, short name for, 388

Nature Background, 100
navigating

in dialogs, 9
with VoiceOver, 121, 122
Web pages, 228-229

nesting tables, 185
Netscape Navigator, 217, 225

Mail, importing e-mail to, 259
NetStat, 430
network disks, 27

Info window, information in, 50-51
Network Preferences pane, connecting to

Internet with, 224
network printers, 202-203

accessing shared printers, 202-203
installing, 198

networks, 403. See also AirPort; Bluetooth;
LANs (local area networks); network
printers; Network Sharing Service

activity, viewing, 445
Bonjour messaging on, 289
Finder, browsing with, 416-417
other computers, connecting to, 418-419
port configuration, 223
privileges for users and groups, creat-

ing, 406
searching for files on, 417
several computers, connecting to, 418
Sidebar, accessing from, 417
System Information, viewing system

information with, 447
utilities, 430
VPN (Virtual Private Network), VLAN

(Virtual Local Network), connecting
with, 428-429

Windows, sharing Mac files with, 424
Network Sharing Service, 404-405

file sharing, setting up, 406-407
Internet Sharing, 408

Network Utility, 430
New dialog box, 496
no access for network users, 406
nonresponding applications, quitting, 138

notes. See also Mail; Sticky Notes
Keychain, adding secure notes with, 381

NOT operator, searching with, 57
NPR, listening to, 328
NSFNET, 217
NTFS, reformatting with, 468
NTSC format with iMovie, 342
numbered lists, 184

in e-mail message text, 269
numbering

international options, changing, 104-105
recent items, changing numbering of,

98-99
NumPad Commander, 121, 123

O
Open dialog box in Automator, 496
opening

applications, 132-133, 134
Dashboard, 156
disks, 26-27
documents, 28-29
Info window options, 51
recent applications and documents, 39
recently used applications, 134
Scripts menu, scripts from, 511
windows, 12-13

operating system, 1
optimizing hard drive, 441
Option buttons in dialogs, 9
orientation for printing, 205, 206
OR operator, searching with, 57
outlining

document text, 178
fonts, 155

Out of Office message, creating, 286

P
page breaks, inserting and deleting, 183
Page Setup

individual defaults, setting up, 205
for printers, 200
printing and range options, 204-206
for text wrap, 181

pages per minute (ppm), 196
PAL format with iMovie, 342
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Palm OS devices. See PDAs (personal data
assistants)

panes. See also specific panes
working with, 7

paper feed for printing, 207
paper handling for fax documents, 215
paper size for printing, 200, 204, 206
paragraphs

indent markers, 181
spacing, 183

parental controls
for Dictionary, 175
logging activity with, 392
time limits, setting, 393
for user accounts, 391, 392-393

partitioning disks, 467
passwords. See also Keychain

with FireVault, 400
hints, adding, 388
for iChat, 291
iDisk passwords, changing, 365
for Internet connections, 218
for logging out, 23
from login window, 387
for MobileMe account, 352-353
for Mail, 259, 263
password, changing, Apple ID, 398-399
Recovery key, FileVault, 398-399
on shared computers, 3
in Simple Finder, 92
tips on creating, 398

Paste command, 44
pasting

Automator workflows, 503
formatting, 187
ruler, 179

path bar
for windows, 12

PDAs.
Bluetooth with, 412

networks with, 403
PDF files

Auto Save, in Preview, 150-151
documents as PDF files, saving, 209
downloading Acrobat Reader, 209
previewing, 150-151
Safari, viewing in, 247

Saving in, TextEdit, 190
signatures, adding, in Preview, 150-151
Spotlight searches, keywords for, 57
working with, 151

pen cursors, 126
People, Dashboard displaying, 158-159
permissions. See also file permissions

for screen sharing, 422
phones. See cell phones
Photo Album, Automator example for, 497
Photo Booth, 131, 315. See also iChat

animated GIF, creating, 297
capturing photos in, 333
effects, adding, 335
proof sheets, 333
videos

effects, 306
recording, 334

Photo Browser, 268
photographs.

e-mail, inserting in, 268
iChat buddy picture, changing, 297

Photoshop Preview, opening files in, 150
pictures. See images
Pictures folder, 28-29
Ping service, 325, 430
Pipe Organ voice, 116
Places section, Sidebar, 16
Plain Text Encoding pop-up, 165
Plain Text files

documents as Plain Text files, saving, 191
TextEdit preferences, setting, 194

playlists. See iTunes
plug-and-play devices, 450
plug-ins

Automator with, 499, 506
compatible plug-ins, checking, 255
Safari, enabling in, 254

podcasts.
listening to, 326

pointing with mouse, 6
POP (Post Office Protocol), 261
pop-up menus, 8

in dialogs, 9
on toolbar, 17

pop-up windows, blocking, 255
portrait orientation printing, 205, 206
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PostScript files, 201
PDF file, converting to, 150

PowerBook/MacBook
sleeping options, 109
wireless connections, 222

power failure restart options, 108-109
power strips, 450
ppm (pages per minute), 196
PPoE (Point to Point Protocol over

Ethernet), 221
making connection with, 224

PPTP protocol, 428
preferences. See also Finder Preferences;

hardware; iChat; Safari; System
Preferences

Bluetooth preferences, setting, 415
Dictionary preferences, setting, 174-175
Dock preferences, setting, 86-87
iCal preferences, changing, 371
iDisk preferences, setting, 364-365
iTunes preferences, setting, 332
Language & Text, 104-107
MobileMe account preferences, chang-

ing, 352-353
Mail, addressing, 266-267
Sidebar preferences, changing, 84-85
Spotlight preferences, customizing, 64
TextEdit preferences, setting, 194
for Time Machine, 478
VoiceOver preferences, setting, 122-123

presentation keyword for Spotlight, 57
Preview, 131, 150-151
Preview column, Columns view, 37
Preview File Open command, 150
previewing

dialogs, area in, 9
Info window options, 51
printed documents, 208
print image, 206

Print command, 206-207
printer drivers, 197
printers. See also Bonjour; network printers

adding or removing, 198-199
default settings, setting, 200
description of, 196
desktop printers, using, 207

IP (Internet Protocol)
for installing printers, 199
for sharing printers, 202-203

manually adding, 198-199
Network Sharing Services, 404
PostScript Printer Desc. (PPD) files, 201
sharing, 202-203, 404
Sharing Service, 404
specific settings, setting, 201

Printer Setup Utility, printer drivers in, 197
Printers folder, displaying printers in, 207
Print & Scan preferences, 200-201
printing, 195

from Address Book, 143
Automator workflow, 505
basic print options, setting, 206-207
cover pages, creating, 207, 211
e-mail messages, 281
help topics, 73
iCal calendar and Reminder lists, 377
Page Setup options, 204-205
previewing printed documents, 208
queues, managing, 207, 210
reverse order printing, 207
saving print options, 215
to shared printers, 203
two print jobs with two printers, 205
Web pages, 246

Print Queue utility, 207
privacy preference in Spotlight, 64-65
Private Browsing, 228
privileges for users and groups, 406
proof sheets in Photo Booth, 333
protocols, 261
proxies, 218
Public folder. See also iDisk

in Home folder, 28-29, 47, 402
publishing iCal calendar, 374
pull-down menus, 8
Push button in dialogs, 9

Q
Quartz Extreme enhanced graphics, 100
Quartz Filters

Automator example workflow for, 497
for printed documents, 207
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Quick Erase setting, 329
Quick Look

attachments, viewing, 276-277
toolbar button, 17
viewing files with, 38

QuickTime movies, 334
iMovie, 342
streaming options, 338-339
in theater presentations, 307

QuickTime Player, 131, 315
creating and editing movies, 340-341
full-screen, 338-339
playing movies, 338-339

publish to MobileMe, YouTube, Vimeo,
Flickr, Facebook, and Mail, 340-341

quitting applications, 138
rotate movies, 338-339
sharing movies, 340-341

quoting text in e-mail, 274

R
radio. See also Internet Radio

podcasts, listening to, 326
raising characters, 182
read and write permissions

for moving/copying files, 45
for network users, 406
in Shared folder, 47

read-only permissions
documents as read-only files, 190
for moving/copying files, 45
for network users, 406
in Public folder, 47

Reading button, Safari, 226
using, 232-233

Reading List, Safari, 226
using, 232-233

Recent Folders list, 39
recently used items

applications, opening, 134
documents, opening, 165
numbering, changing, 98-99

recording
AppleScripts, 510
Automator actions, 502
video chats, 307

recovering. See restoring
Recovery key, FileVault, 398-399
Redo command, 43
redoing. See undoing/redoing
refresh rate, setting, 456
registration symbol, inserting, 188
reloading Web pages, 228-229
Reminders lists. See also Mail

iCal, creating with, 376
removable disks, 27

Info window, information in, 50-51
Rendezvous Web sites, adding, 238
replacing. See finding/replacing
resizing. See size/resizing
resolution

monitor resolution, setting, 456
of printers, 196

restarting, 24
forcing a restart, 448
from Login window, 3
with Mac OS X, 110, 442
power failure restart options, 108-109
in Target Disk Mode, 110
Time Machine backup for, 481

restoring
calendar with iCal, 373
compressed files and folders, 436
deleted files and folders, 48-49
disk image, 489
e-mail, 280
master password, restoring, 398-399

Return key, 9
reverse order

fax documents, sending, 215
printing pages in, 207

RGB (Red, Green, Blue) colors, 458
right-alignment

of document text, 178
of tables, 184

right indent marker, 181
routers, 218, 408
RSS feeds. See also Safari

customizing, 240
Mail, subscribing in, 288
widgets and, 156

RTFD files, documents as, 164
RTF files
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documents as, 164, 190
formatting text in, 178

rulers, showing/hiding, 179

S
Safari, 131

Address Book to Bookmarks bar, adding,
238-239

advanced preferences, setting, 253
alerts for nonsecure forms, 243
appearance (general) preferences, 

setting, 253
AutoFill preferences, setting, 242
bookmarks, 226

creating and deleting pages, 237-239
folder, creating, 238
organizing, 239
for RSS feeds, 240-241
Spotlight searches, keywords for, 57
synching on multiple computers, 239
tabs, opening with, 230-231

Bookmarks Library, 237
deleting bookmarks in, 238-239
organizing bookmarks in, 239
renaming collection, 239

cache, emptying, 236
compressing/uncompressing disk

images, 251
cookies, preferences regarding, 254
copying text from Web page, 249
customizing window, 226
default browser, selecting, 256
deleting

bookmarks, 238-239
History list entries, 236

different window, opening page in, 231
disk images, downloading, 251
downloading

files, downloading, 250-251
Home page, 252

Downloads window, working with files
in, 250-251

encoding preferences, setting, 253
extensions, 252
font preference, setting, 253
forms, filling out, 242-243
full-screen app, using, 135
general preferences, setting, 252

grammar-checking in, 243
help information in, 72
History list

clearing settings, 256
preferences, setting, 252
viewing, 236

Home page
changing, 235
going to, 228-229
preferences, setting, 252

HTML code, viewing, 248
navigating in, 228-229
nonworking Web pages, 255
opening Web pages in, 228
PDF files, viewing, 247
pictures from Web page, saving, 249
pop-up windows, blocking, 255
preferences

advanced preferences, 253
general preferences, 252-253
security& privacy preferences, 

setting, 254
printing Web pages, 246
reloading pages, 228-229
resetting settings for, 256
RSS feeds

bookmarking, 240-241
customizing, 240

saving
information in Web page, 248-249
text of Web page, 248

security
pop-up windows, blocking, 255
preferences, setting, 254

security & privacy preferences, setting,
254

size of text, changing, 231
SnapBack page, 245
spell-checking in, 243
starting application, 226
style sheet preferences, 253
synching bookmarks on computers, 239
tabs

opening Web page with, 230-231
setting browsing options for, 230

Top Sites, 234
viewing window, 227
Web Clip widgets, creating, 162
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Safe boot, performing, 464
Save As dialog box, 190
saving. See also Safari

attachments, files in, 277
Automator workflow, 505
Bonjour chats, 309
e-mail, 282
Keychain, changes in, 383
print options, 215
Smart folders, copy of, 71
Web page information, 248-249

scanning
documents, 212-213
images, 212-213

scanner information, viewing, 447
scheduling. See also iCal

fax documents, 215
faxes, 215

screen savers, setting up, 101
screen sharing

permissions, setting, 422
using, 423

screen shots, capturing, 149, 340-341
Script Editor, 510

Application Services with, 436
Script menus. See also AppleScripts

adding scripts to, 509
Automator workflow from, 506
displaying, 508
opening scripts from, 511

scroll bars
changing action of, 98
options, changing, 98

search boxes
in Automator, 493, 494
on toolbar, 17
for windows, 12

search engines, 244-245
Search For section, 16

Smart folders, using, 70-71
searching. See also Dictionary;

finding/replacing; Find window;
Spotlight

Automator workflows, 503
e-mail for text, 283
for hard to find information, 68
for help, 72-73
Internet, 244-245

metadata searches, 68
network, files on, 417
with VoiceOver, 121

secret folder hierarchy menu, 39
security. See also Keychain; passwords;

Safari
Internet security, 219
for logging out, 23
for switching between users, 22-23
security & privacy preferences, setting,

397
selecting

documents, text in, 166
icons, 10

Sepia effect, 335
servers. See also Mail

Find window searching, 66
Mac OS X Server account, 258
Web Sharing service, 404

Shared folder in Home folder, 47, 402
Shared section, Sidebar, 16
sharing. See also network printers; Network

Sharing Service; screen sharing
Address Book, 140, 144-145
buddies, screens with, 309
Home folder, sharing files in, 402
iCal calendars, 374
iChat screens, 309
Internet connections, 219
Network Sharing Services, 404-405
printers, 202-203, 404
starting on shared computer, 2-3
widgets, 156
Windows, Mac files with, 424
Windows Vista computers, connecting

from, 425
Sharing Preferences, 404
shortcuts. See aliases; keyboard shortcuts
Show All command on Spotlight menu, 58
showing/hiding. See also Dock

applications, 136
Dashboard, widgets on, 158
with Exposé, 20
file extensions, 79
List view, folders in, 34
Mailbox list, 279
rulers, 179
Sidebar and toolbars, 16-17, 84
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Show Inspector, 50
Show Modem Status menu, 220
Show View Options command, 32
shutting down, 24

from Login window, 3
options, setting, 108-109

Sidebar
customizing, 84-85
networks, accessing, 417
preferences, changing, 84-85
shared devices, displaying, 420
showing/hiding, 16, 17, 84
Smart folders, using, 70-71
using, 16
for windows, 12

sight impaired users, preferences, 118-119
signatures to e-mail, 270

adding, in Preview, 150-151
Simple Finder, 92
size/resizing. See also compressing/uncom-

pressing
files and folders arranged by size, 33
Find window searches by size, 67
font size, 178
help text, 73
Web page text, 231
windows, 12, 14-15

Ski Report, Dashboard displaying, 158-159
sleep mode, 24

faxes, turning off to receive, 216
from Login window, 3
setting sleep options, 108-109

slider in dialogs, 9
slideshows for Spotlight results, 63
Slow Keys, 118-119
Smart folders

changing search criteria for, 71
creating and editing, 70-71
saving copy of, 71
Sidebar, using in, 70-71

Smart Mailbox, creating, 287
Smart Magnify tool, Preview, 150-151
Smart Playlists, building, 322-323
smart searches with VoiceOver, 121
SMB/CIFS

file services, 424
sharing printers with, 202-203

smileys in instant messages, 300-301

smoothing fonts on screen, 457
SMS (short message service) text, sending,

308
SMTP (Simple Mail Transfer Protocol), 261
SnapBack page, 245
Snap to Grid setting, 33
software. See also hardware

automating updates, 433
compatibility, checking for, 464
downloading, 432
installing, 432
removing hardware device software, 464
uninstalling, 48, 432

Solid Colors Background, 100
sorting

by color labels, 40-41
e-mail messages, 279
Find window file results, 69
List view, files and folders in, 34-35
Spotlight results, 62
widgets, 161
sounds. See also alerts; VoiceOver
changing sound effects, 112
dates and times, announcing, 103
input options, setting, 113
MIDI devices, configuring, 462-463
output options, setting, 113
Spotlight searches, keywords for, 57

Spacebar with spring-loaded folders, 46
Spaces. See also Mission Control

customizing, 90-91
Dashboard preferences, changing, 157
grouping windows into, 21

spacing
character spacing, changing, 182
line spacing, changing, 183

Speakable Commands window, 114
speaking voice. See also Alex; VoiceOver

document text, speaking, 175
for e-mail, 268
interface options, setting, 117

speech recognition, 114-115. See also Alex
with Address Book, 140, 143
Application Services with, 436
enabling, 115
for Sticky Notes, 153
using, 115
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speed of printers, 196
spell and grammar checking, 163

adding words to dictionary, 172
for documents, 172-173
e-mail, 265
in Safari, 243
in Spotlight, 59

Spotlight, 55
backed-up items, recovering, 482-483
canceling search, 57
desktop icon, 5
e-mail, searching for, 283
filtering results, 60
finding information with, 56-57
grouping results, 62
help with, 74
keyboard shortcuts, setting, 64-65
keywords for searches, 57
metadata, finding information with, 57
preferences, setting, 64-65
privacy preferences, setting, 64-65
sorting results, 62
viewing results in window, 58-59
windows, working with, 58-59
working with results, 63

Spotlight Search box, 74
spring-loaded folders

customizing, 78
using, 46

stacks on Dock, 19
starting. See also restarting

Automator, 495
Bonjour messaging, 309
CDs, changing start settings for, 111
DVDs, changing start settings for, 111
with Fast Startup Switch, 442
iChat, 292
iTunes, 316
Mac for Windows, 470-471
Mac OS 9 disk, starting from, 442
power failure restart options, 108-109
Safe boot, performing, 464
specifying startup items, 394-395
stand-alone computer, 2

Startup commands, 395, 399
startup disk, 26-27

selecting, 110

Startup Disk Control Panel, 110
stationery for e-mail, 268
Stationery Pad in Info window, 50-51
status bar

in Safari, 226
for windows, 12

status menus
in iChat, 294-295
Internet, connecting to, 224

Sticky Keys, 118-119
Sticky Notes, 131

Application Services with, 436
creating, 153
Dashboard displaying, 158-159

Stocks, Dashboard displaying, 158-159
Stuffit Expander, 33, 129a, 434
styles

deleting style favorites, 186-187
documents, applying to, 186-187
favorite styles, applying, 186-187
for fonts, 155
Safari style sheets, 253
toolbar styles, changing, 83

submenus, 8
subnet masks, 218
subscribing

to Address Book, 145
to iCal calendar, 374-375
to podcasts, 326
to RSS feeds, 288

subscript characters, 182
summary

of Application Services, 436
of printer options, 207

superscript characters, 182
surge protectors, 450
switching

between applications, 136-137
between Dock applications, 18
Fast User Switching, enabling, 396
between help libraries, 72
between users, 22-23
between windows, 14

symbols. See also copyrights; trademarks 
registration symbol, inserting, 188

synchronization. See also MobileMe,
Yahoo!, iPhone, iPad, iPod touch syn-
chronization
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of Address Book, 140
Safari bookmarks on multiple 

computers, 239
System Administrator. See Administrator
System folder, 26-27
System Preferences, 93. See also hardware;

monitors; QuickTime movies;
VoiceOver

Bluetooth preferences, setting, 415
dates and times, setting, 102-103
description of, 94-95
desktop backgrounds, changing, 100
general preferences, changing, 98-99
ink preferences, setting, 126
international options, changing, 104-105
Internet preferences, list of, 94-95
keyboard settings, changing, 453
language & text options, 171, 172
locking/unlocking, 97
mouse settings, changing, 454
network preferences, list of, 94-95
overall preferences, list of, 95
personal preferences, list of, 94
Print & Scan preferences, 200-201, 

202-203
screen savers, setting up, 101
Security & Privacy pane, 397
sleeping options, setting, 108-109
sounds, controlling, 112-115
speaking voice, setting, 116-117
speech recognition options, 114-115
Spotlight searches, keywords for, 57
Startup disk, selecting, 110
Universal Access preferences, 118-119
viewing, 96

System Information, viewing system infor-
mation with, 447

system recovery with Time Machine, 484

T
tab bars in Safari, 226
tables

cells, 184-185
documents, adding to, 184-185
merging cells in, 185
nesting tables, 185

tabs. See also Safari
in dialogs, 9

paragraph tabs, setting, 180
tab stops, setting, 180
tactile feel of keyboard, 453
Take Video Snapshot button, 142
.tar files, opening, 434
Target Disk Mode, restarting computer, 110
TCP/IP, 422

for modems, 220
telephones. See cell phones
television podcasts, listening to, 326
text. See also documents; Mail

encoding, selecting, 226
iChat chat as text, viewing, 311
in Safari, 226
substitution, preferences, 106-107

TextEdit, 29, 131, 163. See also documents
Application Services with, 436
automatic opening documents in, 79
Page Setup options, 204-205
preferences, setting, 194
speaking text in, 175
for Web design, 192-193

text substitution, 106-107, 171
text wrap

changing, 181
TextEdit preferences, setting, 194

theater presentations, hosting, 306-307
thesaurus, 174
third-party applications. See also software

installing, 129a
System Preferences, 95

threads, sorting e-mail by, 279
Time Capsule, 478, 481
Time Machine, 131, 477

entire computer system, recovering, 484
excluding items from backup, 480
preferences, setting up, 478
previous version of Mac OS X, reverting

to, 484-485
recovering backed-up items, 482-483
restarting backup, 481
setting up, 478
starting manual back up, 479
system, recovering, 484-485
working with backup, 481

time management. See iCal
times. See dates and times
time zones, setting, 102
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title bars
aliases, creating, 89
for windows, 12

toolbars. See also Automator
adding icons to, 83
customizing, 82-83
deleting icons from, 83
Finder toolbar, customizing, 82-83
parts of, 17
rearranging icons on, 83
in Safari, 226
showing/hiding, 16, 17
styles for, 83
for windows, 12
working with, 7

trackpad, 6
trademark symbols

documents, inserting in, 188
Translation, Dashboard displaying, 158-159
Trash, 10

empty Trash warning, turning on/off, 49,
79

files and folders in, 48
securely deleting files and folders, 49
software, uninstalling, 48, 432
uninstalling software with, 48, 432

transfer information
between Mac and PC, 443

troubleshooting
Bonjour problems, 308
disk problems, 440
hardware problems, 464
Safe boot, performing, 464

turning on/off. See also iChat
Bonjour, 308
Dock hiding, 18
empty Trash warning, 49, 79
FireVault, 400
gestures, 126
keyboard shortcuts, 9
spring-loaded folders, 46

Twitter, connect with Ping, 325

Safari extension, 252-253

U
underlining

document text, 178

e-mail message text, 269
fonts, 155

Undo command, 43
undoing/redoing

Address Book mistakes, 143
documents, actions in, 170
file deletions, 49
in Finder, 43
ink recognizing, 126

Unicode for languages, 165
uninstalling

hardware, 451
software, 48, 432

Unit Converter, Dashboard display, 158-159
Universal Access, 118-119. See also

VoiceOver
Automator actions and, 502

UNIX compressed files, opening, 434
unmounting networks, 54
updating

automating software updates, 433
from Boot Camp beta, 467
widgets, 157

up/down arrows in dialogs, 9
URLs (Uniform Resource Locators), 228

Application Services with, 436
home page, typing address for, 235

USB
FireVault protecting, 400

user accounts, 386
access privileges, setting, 391
adding, 388
deleting, 389
Fast User Switching, enabling, 396
file permissions, setting, 390
parental controls, setting, 391, 392-393
short name for, 388

user & groups preferences, 94-95. See
accounts and user accounts.

user names for Internet connections, 218
Users folder, 26-29
Utilities folder, 489

V
Variable list on Automator window, 492-

493, 494
vCards, 141, 144-145
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in attachments, 276
e-mail, including with, 270

verbosity preferences, setting, 122
video cameras, 291
videos. See also DVD Player; iChat; Photo

Booth; QuickTime movies; QuickTime
Player

animated GIF, exporting movie as, 335
Dashboard displaying, 158-159
documents, adding to, 189
iMovie, 342
Spotlight searches, keywords for, 57

View buttons on toolbar, 17
views and viewing. See also specific views

changing window views, 30-31
customizing views, 30
disks, viewing, 26-27
documents, viewing, 28-29
hardware settings, 452
iCal window, 368
iTunes window, 317
System Preferences, 96

Vimeo, QuickTime, 340-341
Virtual Network Computing (VNC), 422
visible files, searching for, 67
VoiceOver, 118

Braille, support for, 120, 123
commands, using, 124-125
description of, 120-121
hot spots, 121, 124
keys for, 121
preferences, setting, 122-123
searches and utility, 121

VO keys, 121
volume. See sounds
Volume desktop icon, 5
VPN (Virtual Private Network), 428
VLAN (Virtual Local Area Network), 429

W
Wacom for handwriting recognition, 168
waking up options, setting, 108-109
Watch Me Do action, 502
Weather, Dashboard displaying, 158-159
Web addresses. See URLs (Uniform

Resource Locators)

Web browsers, 225. See also Safari
default browser, selecting, 256
history of, 217
Mail, starting, 259

Web Clips widget, creating, 162
Web pages. See also HomePage; RSS

feeds; Safari
copying text from, 249
different window, opening page in, 231
Image Capture, building with, 148
navigating, 228-229
nonworking Web pages, 255
printing, 246
reloading, 228-229
saving, 248
searching within, 244-245
size of text, changing, 231

Web sites, 225. See also HomePage; Web
pages

for printer driver downloads, 197
Whois service, 430
widgets, 156. See also Dashboard
Wikipedia, 174
windows, 1

activating, 12-13
Columns view opening new windows, 37
Exposé, using, 20
Finder Preferences for customizing, 78
mouse, resizing with, 15
opening/closing, moving, 12-14
sizing/resizing, 12, 14-15
spaces, grouping windows into, 21
switching between, 14
TextEdit preferences, setting, 194
views, changing, 30-31

Windows Media
Boot Camp Assistant and, 465
with Mac for Windows, 472

Windows 7 or Vista. See also Mac for
Windows

LANs, connecting to, 425
upgrading Windows XP to, 468

Windows XP. See also Mac for Windows
LANs, connecting to, 426-427
outside network, connecting, 426-427
upgrading to Windows Vista, 468

WinZip, opening files compressed by, 434
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wireless connections, 218. See also AirPort;
Bluetooth

infrared technology, 223
WordPerfect Page Setup options, 204-205
workflow. See Automator
World Clock, displaying, 158-159
write-only permissions for net users, 406
WYSIWYG, 208

X
X-Ray effect, 335

Y
Yahoo! Address Book,

importing and syncing, 141
creating an account, 144-145, 258

Yahoo! calendar account, 258, 368
Yahoo! instant message account, 290-291

YouTube, QuickTime, 340-341

Z
Zoom button, 12, 15
zooming in/out

with DVD Player, 337
in Preview, 151
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